
HƯỚNG DẪN SỬ DỤNG HỆ THỐNG THƯ ĐIỆN TỬ TÂY NINH BẰNG 

EMAIL CLIENT. 

 

I. Cấu hình mail MS Office Outlook: 

1. Giới thiệu: 

Hiện nay với việc ứng dụng hệ thống thư điện tử phát triển. Để người dùng có thể 

chọn lựa các trình duyệt, phần mềm hỗ trợ ứng dụng cho việc Check Mail trên Server 

của Tổ chức, Công ty, doanh nghiệp,… là rất phong phú. Ở tài liệu này Chúng tôi sẽ 

hướng dẫn các Anh (Chị) cách cấu hình Microsoft Office Outlook tích hợp sẳn trong 

bộ Office, xử dụng Microsoft Office Outlook  phiên bản 2003 

Ghi chú: Do yêu cầu, tài liệu viết trên bộ Microsoft Office Outlook. Nên các Anh, 

(Chị) cần cài bộ Microsoft Office lên máy tính của mình trước khi thực hiện thao tác 

như tài liệu. 

2. Cài đặt: 

Ứng dựng mail MS Office Outlook được tích hợp cùng với bộ cài đặt Office (2003, 

2007…). 

3. Cấu hình: 

Trên màn hình giao diện Windows, Click chuột chọn “Start/programs/Microsoft 

Office/Microsoft Office Outlook 2003” như hình minh họa bên dưới. 

 

 

 

Hình 1: Hình minh họa khởi động Phần mềm microsoft Outlook 2003 

 

Sau khi mở trình làm việc Microsoft Office Outlook 2003 lên sẽ xuất hiện với màn 

hình giao diện như sau: 
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Hình 2: Màn hình chính của Phần mềm microsoft Outlook 2003 

Để sử dung Microsoft Outlook check mail, các Anh (Chị) bước đầu tiên phải có tài 

khoản do người quản trị trên hệ thống Mail Server tạo. Bước tiếp theo các Anh (Chị) 

tiến hành cấu hình tài khoản trên Microsoft Office Outlook theo các bước sau: 

Bước 1: 

Từ màn hình giao diện chính của Phần mềm Microsoft Office Outlook, Click chuột 

chọn Tools/Options… 

Ghi chú: Để cấu hình tài khoản trên Microsoft Office Outlok ở bước 1 này các Anh 

(Chị) có thể chọn E-mail Accounts… hoặc Options…Ở tài liệu hướng dẫn này hướng 

dẫn các Anh (Chị) chọn “Tools/Options…”: 

 

 

Hình 3: Màn hình cấu hình check mail Outlook 

 

Sẽ xuất hiện hộp thoại như sau: 
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Hình 4: Màn hình cấu hình check mail Outlook 

 

Click chuột trên thanh công cụ chọn “Mail Setup/E-mail Accounts…” xong Click 

chuột chọn “OK” xuất hiện hộp thoại sau: 

 

 

Hình 5: Màn hình cấu hình check mail Outlook 

Click chuột check vào ô “Add a new e-mail account” xong click chọn “Next” xuât 

hiện hộp thoại tiếp theo như hình minh họa bên dưới: 
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Hình 6: Màn hình cấu hình check mail Outlook 

Click chuột check chọn ô “POP3” xong click chọn “Next” 

 

Hình 7: Màn hình cấu hình check mail Outlook 

 

- Your Name: Nhập tên cá nhân, đơn vị, tổ chức,…tương ứng. 

- E-mail Address: Nhập tên + với domain hệ thống mail Server. Ở đây Anh (chị) 

tạo tài khoản cho “longxuyen” Nên sẽ là “thanhtra@tayninh.gov.vn. 

- Incoming mail server (POP3): địa chỉ nhận mail đi qua hệ thống mail Server 

”pop3.tayninh.gov.vn”. 

- Outgoing mail server (SMTP): địa chỉ gửi mail đi qua hệ thống mail Server 

“smtp.tayninh.gov.vn”. 

- Username: Nhập tên do người quản trị hệ thống mail server tạo. 

- Password: Nhập mật khẩu do người quản trị hệ thống mail server tạo. 
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Sau khi nhập thông tin như hình minh họa bên trên. Click chuột chọn “Test Account 

Settings” để kiểm tra thông tin tài khoản có kết nối được với hệ thống mail server 

không. Xuất hiện hộp thoại sau: 

 

 

Hình 8: Màn hình cấu hình check mail Outlook 

 

Quan sát thấy tài khoản đã kết nôi với hệ thống mail server thành công, Click chuột 

chọn “Close” để đóng hộp thoại lại. 

 

 

Hình 9: Màn hình cấu hình check mail Outlook hoàn tất 

 

Click chuột chọn “Finish’ để kết thúc quá trình cấu hình tài khoản check mail bằng 

Phần mềm Microsoft Office Outlook qua hệ thống Mail Lotus domino. 
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Hình 10: Màn hình cấu hình check mail Outlook 

Tiếp theo click chuột chọn “OK” để đóng màn hình giao diện khởi tạo cấu hình tài 

khoản lúc đầu. Đến đây quá trình cấu hình tài khoản đã hoàn tất. 

 

4. Sử dụng: 

Từ giao diện màn hình chính của Microsoft Office Outlook. Click chuột chọn 

“Send/Receive All” hoặc nhấn “F9” để kiểm tra mail mới như hình minh họa bên dưới 

 

 

 

Hình 1: Màn hình cập nhật mail đến, đi 
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 Click chuột chọn “Mail’ di chuyển qua thư mục “Inbox” để check mail gửi đến. 

 

 

Hình 2: Màn hình mở mail đến 

 

 

Hình 3: Màn hình đọc mail đến 

Click chuột chọn thư “mail’ muốn đọc nhấp chuột “double” hoặc đưa con trỏ chuột lên 

thư “mail’ muốn xem tiếp theo nhìn phía bên phải màn hình sẽ thấy được nội dung thư 

gửi đến. 
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Click chuột chọn thư “mail’ cần đọc, đưa trỏ chuột chọn ‘Attachments” nhấp chuột 

“double” trên tên file đính kèm. 

 

 

Hình 1: Màn hình đọc mail đến 

 

Xuất hiên hộp thoại sau: 
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Hình 2: Màn hình đọc mail đến 

 

Click chuột chọn “Open” nếu muốn mở trực tiếp hoặc có thể chọn “Save’ để lưu về 

máy tính trước khi mở lên đọc file đính kèm 

 

Để gởi và kiểm tra những mail đã gởi đi: 

Trên màn hình chính đưa con trỏ chuột lên thanh Menu chọn “New/mail Message” 

hoặc từ bàn phím nhấn phím tắt “Ctrl+N”. 

 

Hình 1: Màn hình tạo mail gửi đi 

 

Xuất hiện hộp thoại giao diện sau: 

 

 

Hình 2: Màn hình tạo mail gửi đi 

 

- To…: Nhập địa chỉ mail cá nhân, tổ chức, công ty, doanh nghiệp,… nhận mail. 

- CC…: Nhập địa chỉ mail cá nhân, tổ chức, công ty, doanh nghiệp,… đồng 

nhận 

- Subject: Tiêu đề chính mail muốn gửi 

Sau khi nhập thông tin và nội dung mail muốn gửi Click chuột chọn “send’ để hoàn tất 

việc mail gửi đi. Để kiểm tra lại nội dung,… mail đã gửi đi Click chuột chọn “Sent 

Items” nhìn chính giữa màn hình thấy tất cả các mail đã gửi đi. Muốn xem lại chỉ cần 
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Click chuột lên mail muốn kiểm tra bằng cách nhấp chuột 2 lần hoặc nhìn phía bên 

phải màn hình. Như hình minh họa bên dưới: 

 

II. Cấu hình mail Thunderbird: 

1. Giới thiệu: 

Mozilla Thunderbird là phần mềm mă nguồn mở dùng để  gửi và nhận email được 

phát triển bởi hãng Mozilla. Thunderbird đang được sử dụng rộng rãi và có các tính 

năng tương đương phần mềm thương mại Microsoft Office Outlook. 

Bạn có thể download và sử dụng miễn phí miễn phí Thunderbird tại địa chỉ 

http://www.mozilla.com, phần mềm này có thể chạy trên các hệ điều hành Windows 

98, ME, Windows NT, Win2K, XP, Vista, 7, Mac, Linux, Unix. Phần mềm Mozilla 

Thunderbird được giới thiệu trong tài liệu này là phiên bản 6.0. 

Lần đầu làm quen với phần mềm, cách học nhanh nhất là đọc hết tài liệu, sau đó tiến 

hành thực hành ngay trên máy tính khi kết thúc mỗi phần, nếu có vấn đề khúc mắc 

người sử dụng tra cứu lại tài liệu để hiểu rơ ràng hơn. 

2. Cài đặt: 

Chạy file Thunderbird Setup.exe hộp thoại sau xuất hiện: 

 

Hình 1. Hộp thoại Mozilla Thunderbird Setup 

Nhấn chuột vào Next 

http://www.mozilla.com/
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Hình 2. Hộp thoại Softwave License Agreement 

Chọn I Accept the terms of the License Agreement, nhấn Next hộp thoại sau xuất hiện 

 

 

Hình 3. Hộp thoại Setup Type 
 

Chọn Standard để mặc định chuẩn của Thunderbird. Nếu bạn chọn Custom th  có thể 

lựa chọn thay đổi các thông số như lựa chọn cài đặt phần mềm tại thư mục nào trong 

máy tính, có tạo biểu tượng phần mềm trên Desktop, trên thanh Start, Quick 

Launch hay không,… Bạn nên ngầm định chọn chế độ Standard. 

- Nhấn nút <<Next>>, xuất hiện màn h nh thể hiện tiến t nh cài đặt: 
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Hình 4. Hộp thoại Select Components 

Chọn Next để tiếp tục, hộp thoại sau xuất hiện 

 

Hình 5. Hộp thoại Installing 

Đợi cho cài đặt hoàn tất 
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Hình 6. Hộp thoại Install Complete 
 

Nhấn Finish để hoàn tất việc cài đặt. 

 

3. Cấu hình: 

a. Khởi động chương trình Thunderbird: 

Chọn Menu Start → Programs → Mozilla Thunderbird hoặc nhấn đúp chuột vào 

biểu tượng  Thunderbird ở bất cứ chỗ nào mà bạn thấy trên màn hình. 

b. Thoát khỏi Thunderbird 

- Cách 1: Vào menu File\Exit. 

- Cách 2: Nhấn nút   tại góc trên bên phải màn hình. 

 

c. Thiết lập cấu hình Thunderbird: 

Chọn File → New→Mail Account… để  tạo một tài khoản mới. Hộp thoại sau 

xuất hiện 

 



Tài Liệu Hướng Dẫn Sử Dụng – Mail Lotus                                                                    Phiên bản 1.0 

 

14 
 

 

Hình 7. Hộp thoại Account Wizard – Mail Account Setup 

Chọn Email account, và mật mã sau đó  nhấn chuột vào Continue, hộp thoại 

kiểm tra thông tin mail sau xuất hiện 

 

 
Hình 8. Hộp thoại Account Wizard - Configurataion 

 

Sau khi chương trình kiểm tra thông tin xong. Màn hình yêu cầu xác nhận lại 

thông tin. 
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Hình 9. Hộp thoại Account Wizard – Mail Account Setup 2 

 

Nếu muốn cài đặt bằng tay thì ta chọn “Manual config” để thiết lập các thông số 

tương tự như màn hình sau: 

 

 
 

Hình 10. Hộp thoại Account Wizard – Mail Account SetupManual 
 

Chọn “Create Account” để tiếp tục.  
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Hình 11. Hộp thoại Account Wizard – Mail Account SetupWarning 

 

Check vào I understand the risks và chọn “Create Account”. Ok để hoàn tất 

 

Đến đây, về cơ bản bạn đã thiết lập xong cấu hình, có thể gửi và nhận email. 

d. Sử dụng font chữ tiếng Việt 

Giả sử có ai đó gửi cho bạn một email với nội dung được soạn thảo bằng tiếng 

Việt có dấu, nhưng bạn không đọc được email đó. Bạn nhấn vào Tools → 

Options, chọn mục Display, vào thẻ Fonts → Advanced… thiết lập như hình vẽ là 

bạn có thể  đọc được email tiếng Việt. 
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Hình 12. Hộp thoại Options - Fonts 

 

e. Thiết lập chữ ký trong Thunderbird: 

Trong mỗi email khi gửi đi bạn muốn tự động để lại thông tin của mình ở phần 

cuối của email. Chữ ký trong Thunderbird giúp bạn thực hiện điều này một cách 

dễ dàng. 

Bước 1: Soạn thảo nội dung chữ ký bằng một chương trình soạn thảo văn bản nào 

đó, lưu nó dưới dạng .odt, .html, hoặc có thể là một file dạng ảnh v.v.. 

Bước 2: Chọn menu Tools → Account Setting hộp thoại sau xuất hiện 
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Hình 14. Hộp thoại Acount Settings 

 

Đánh dấu vào Attach this signature, nhấn chuột vào nút Choose chọn đường dẫn 

đến file chứa nội dung chữ ký, bấm OK để hoàn tất. Hoặc chọn Attach my vCard 

to messages, bấm chuột vào nút Edit card hộp thoại sau xuất hiện: 

 

 

Hình 15. Hộp thoại Edit vCard 

 

Điền đầy đủ thông tin vào các Tab của hộp thoại trên, bấm OK để hoàn tất. 

 

f. Quản lý email theo nhóm: 

Giả sử, email của bạn được gửi từ nhiều nguồn khác nhau. Để thuận tiện cho việc 

quản lý email theo từng nhóm, từng chi nhánh, chức năng Filter của Thunderbird 
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sẽ giúp bạn. Thực hiện theo các bước sau: 

- Bấm phải chuột vào Inbox chọn New Folder như hình vẽ, đặt tên cho 

Folder 

 

Hình 16. Tạo thư mục mới 
 

Chọn Tools → Message Filter hộp thoại sau xuất hiện: 

 

Hình 17. Hộp thoại Message Filters 

Bấm chuột vào nút New hộp thoại sau xuất hiện. Điền đầy đủ thông tin vào hộp 

thoại như sau: 



Tài Liệu Hướng Dẫn Sử Dụng – Mail Lotus                                                                    Phiên bản 1.0 

 

20 
 

 

Hình 18. Hộp thoại Filter Rules 
 

Ý nghĩa của các thông tin trên hộp thoại như sau: 

TP HCM: Tên nhóm, hoặc chi nhánh. Sẽ chọn trong tất cả các email gửi  đến 

hộp thư  của bạn, email nào có phần tên miền kết thúc với hcm.cinotec.com.vn sẽ 

được di chuyển đến thư mục TP HCM đã tạo trước trong mục Inbox. Nhấn OK, 

hộp thoại sau xuất hiện 

 

 

Hình 19. Hộp thoại Message Filter 

Bấm chuột vào nút Run Now, các email sẽ được di chuyển vào thư mục theo ý 

bạn. Làm tương tự với các nhóm còn lại. 

 

4. Sử dụng: 

a. Soạn thư: 

- Vào menu Message\New Message, hoặc nhấn chuột vào biểu tượng 

Write  trên thanh công cụ, hoặc nhấn tổ hợp phím Ctrl+N, xuất hiện 
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cửa sổ soạn thảo thư. 

 

Hình 20. Hộp thoại New Message  

 

Nhập địa chỉ người nhận vào dạng “To:”, ví dụ: truongphong@tayninh.gov.vn 

- Đặt tiêu đề thư tại ô Subject.  

- Soạn nội dung thư  tại ô trắng bên dưới. Bạn có thể  căn chỉnh nội dung 

thư bằng các công cụ nằm phía trên của ô này. Ví dụ: Chọn chữ đậm, 

nghiêng, chèn ảnh,... 

 

b. Gửi thư 

Sau khi hoàn thành nội dung thư, bạn thực hiện một trong những cách sau để tiến 

hành gửi thư: 

- Cách 1: Vào menu File\Send Now. 

- Cách 2: Nhấn chuột vào biểu tượng Send   trên thanh công cụ để gửi 

thư đến người nhận đã chọn. 

- Cách 3: Nhấn tổ hợp phím Ctrl+Enter, xuất hiện thông báo sau:  

 

mailto:truongphong@tayninh.gov.vn
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Hình 21: Thông báo xác nhận gửi thư hay không 

 

 

Nhấn nút <<Send>> để gửi thư. 

 

c. Nhận thư 

Để kiểm tra và nhận những thư mới, thực hiện một trong các cách sau: 

- Cách 1: Vào menu File\Get New Message for\Get All New Messages. 

- Cách 2: Nhấn chuột vào biểu tượng Get Mail  trên thanh công cụ. 

- Cách 3: Nhấn tổ hợp phím Ctrl+Shift+T. 

 

d. Đọc thư 

Sau khi nhấn chuột vào biểu tượng Get Mail, danh sách những thư được lấy về sẽ 

hiển thị trong danh sách tại màn hình chính. Bạn có thể đọc nội dung thư bằng 2 

cách: 

Cách 1: Nhấn chọn thư cần đọc và đọc nội dung thư tại ngăn 
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Hình 22: Cửa sổ giao diện  m thư – Ngăn xem trước thư 

Cách 2: Bấm đúp vào thư cần đọc, nội dung thư sẽ hiển thị tại cửa sổ riêng. 

 

 

Hình 23: Cửa sổ giao diện màn hình thư chi tiết 

e. In nội dung thư 

Để in nội dung thư bạn có thể thực hiện một trong các cách sau: 

Cách 1: 

- Nhấn chọn thư cần in. 

- Vào menu File\Print Preview hoặc nhấn chuột vào mũi tên bên phải nút 

Print  trên thanh công cụ để xem trước khi in. 

- Nhấn chuột vào biểu tượng Print  trên cửa sổ Print Preview 

Cách 2: 

- Nhấn chọn thư cần in. Vào menu File\Print, hoặc nhấn chọn nút Print 

 trên thanh công cụ, hoặc nhấn tổ hợp phím Ctrl+P. 

f. Xoá thư 

Để xoá thư trong danh sách bạn thực hiện theo các bước sau: 

- Chọn thư cần xoá. 

- Vào menu Edit\Delete Message, hoặc nhấn chuột vào biểu tượng Delete 

 trên thanh công cụ, hoặc nhấn phím Delete. 

Thư sau khi xoá sẽ được chuyển vào trong thư mục Trash. Nếu muốn xoá hẳn thư 

nào đó, bạn cần mở thư mục Trash và thực hiện chức năng xoá tương tự như 

trên; hoặc ở bước xoá thư bạn giữ phím Shift đồng thời trong khi nhấn phím 
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Delete. 

 

g. Sao chép văn bản vào nội dung thư 

Nếu bạn đã có sẵn nội dung thư tại một tệp tin nào đó, bạn có thể sao chép nội 

dung đó vào thư cần soạn theo các bước sau: 

- Mở tệp tin chứa nội dung cần sao chép. 

- Bôi đen phần nội dung cần sao chép. 

- Vào menu Edit\Copy, hoặc nhấn chuột vào biểu tượng Copy trên thanh 

công cụ, hoặc nhấn tổ hợp phím Ctrl+C. 

- Mở màn hình soạn thảo thư, đưa con trỏ vào vị trí muốn chèn vào nội 

dung thư. 

- Vào menu Edit\Paste, hoặc nhấn chuột phải và chọn chức năng Paste, 

hoặc nhấn tổ hợp phím Ctrl+V. 

 

h. Gửi thư cho nhiều người cùng lúc 

Nếu muốn gửi một thư cho nhiều người, khi soạn thư bạn nhập địa chỉ email của 

những người nhận vào ô "To:", các địa chỉ email cách nhau bởi dấu phẩy. 

 

 

Hình 24. Hộp thoại CC Message  

 

Bạn cũng có thể nhập địa chỉ email của từng người nhận trên từng  ng “To:” 

bằng cách: Sau khi nhập địa chỉ email của một người nhận, nhấn phím Enter để 
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xuất hiện  ng “To:” tiếp theo. Nhập địa chỉ email của người nhận tiếp theo vào 

đây và lặp lại thao tác trên cho tới khi hết danh sách người nhận. 

 

i. Gửi bản sao 

Trong trường hợp bạn muốn gửi bản sao của thư cho ai đó, sau khi nhập địa chỉ 

email người nhận vào ô "To:", bạn nhấn phím Enter để xuất hiện dụng “To:” 

tiếp theo. Nhấn chuột vào mũi tên bên trái nút "To:" và  chọn "Cc:", sau đó nhập 

địa chỉ email người nhận bản sao vào ô này tương tự như trên. 

 

j. Gửi bản sao ẩn danh 

Khi gửi bản sao theo cách "Cc:", người nhận thư sẽ nh n thấy danh sách tất cả địa 

chỉ email bạn gửi tới. Tuy nhiên, trên thực tế có những tình huống bạn cần gửi bản 

sao cho ai đó nhưng lại không muốn những người nhận khác biết, khi đó hãy nhập 

địa chỉ email của người muốn ẩn đi vào phần "Bcc:". Thao tác chọn "Bcc:" 

tương tự như khi chọn "Cc:". 

 

k. Sắp xếp thư theo một số tiêu chí 

Bạn có thể sắp xếp các thư nhận được theo một số tiêu chí như thời gian nhận thư, 

người gửi thư, tiêu đề thư, dung lượng thư… 

Vào menu View\Sort by. 
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Hình 25. Sort by  

 

Chọn tiêu chí để lọc thư trong danh sách sổ xuống: 

- Date: Nhấn chọn tiêu chí này để lọc thư theo thời gian thư được gửi đi  

- Star: Nhấn chọn tiêu chí này để lọc những thư nào đã được đánh dấu sao. 

- Order Received: Nhấn chọn tiêu chí này để lọc thư theo thứ tự thư đã 

được nhận   

- Priority: Nhấn chọn tiêu chí này để lọc thư theo thứ tự ưu tiên. 

- Sender: Nhấn chọn tiêu chí này để lọc thư theo thứ tự tăng hoặc giảm tên 

của người gửi. 

- Recipient: Nhấn chọn tiêu chí này để lọc thư theo thứ tự tên  m thư nhận 

thư 

- Size: Nhấn chọn tiêu chí này để lọc thư theo thứ tự tăng hoặc giảm kích 

thước của thư gửi đến. 

- Status: Nhấn chọn tiêu chí này để lọc thư theo tình trạng của thư gửi đến 

là mới (New), thư đã được đọc (Read), hoặc thư chuyển tiếp 

(Forwarded). 

- Subject: Nhấn chọn tiêu chí này để lọc thư theo tiêu đề của thư gửi đến. 

- Read: Nhấn chọn tiêu chí này để lọc thư theo tiêu chí thư đã đọc 
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- Tags: Nhấn chọn tiêu chí này để lọc thư theo tiêu chí thẻ đánh dấu   

- … 

l. Đính kèm tệp tin vào thư 

Khi bạn muốn gửi một tệp tài liệu cho ai đó, bạn có thể đính kèm tệp tài  liệu đó 

theo các bước sau: 

Tại màn hình soạn thư, bạn nhấn chuột vào biểu tượng Attach trên thanh công cụ. 

Khi đó, cửa sổ Attach File(s) sẽ hiện ra cho phép bạn chọn tới tệp tài liệu cần gửi. 

 

 
Hình 26. Hộp thoại Attach  file 

 

 

Sau khi chọn tệp tài liệu, nhấn nút <<Open>> để đính kèm tệp tài liệu đó vào thư. 

 

Có thể đính kèm nhiều tệp tài liệu và những tệp tài liệu được đính kèm sẽ hiển thị 

trong ô Attachments bên phải màn hình soạn thư. 

 

m. Trả lời thư 

Để trả lời một thư gửi đến, bạn làm theo các bước sau: 

- Nhấn chọn thư cần trả lời. 

- Nhấn chuột vào biểu tượng Reply  trên thanh công cụ xuất hiện màn 

hình soạn thảo trong đó đã điền sẵn địa chỉ người nhận vào ô "To:" (lấy 

từ địa chỉ đã gửi thư cho bạn), tiêu đề thư sẽ bắt đầu bằng tiền tố "Re:" 

cùng với tiêu đề  của thư trước, đồng thời trích dẫn nguyên toàn bộ nội 

dung thư trước. 

- Soạn nội dung thư trả lời và nhấn chuột vào biểu tượng Send  trên 

thanh công cụ. 

Với cách trả lời trên thì mặc định thư sẽ gửi đến một địa chỉ duy nhất đó là địa 

chỉ đã gửi thư cho bạn. Tuy nhiên, với những lá thư được gửi cho nhiều người, 
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bạn có thể chọn trả lời tất cả mọi người bằng cách nhấn chuột vào biểu tượng 

Reply Al  trên thanh công cụ. 

 

n. Chuyển tiếp thư đã nhận cho người khác 

Nếu bạn muốn chuyển thư đã nhận từ người này cho người khác, hãy thực hiện 

theo các bước sau: 

- Nhấn chọn thư cần chuyển tiếp 

- Nhấn chuột vào biểu tượng Forward trên thanh công cụ xuất hiện màn 

hình soạn thảo sẽ hiện ra trong đó điền sẵn tiêu đề thư sẽ bắt đầu bằng tiền 

tố "Fwd:" cùng với tiêu đề  của thư trước và trích dẫn nguyên toàn bộ nội 

dung thư trước, kể cả tệp tin đính kèm. 

- Nhập địa chỉ người nhận vào ô "To:" rồi nhấn chuột vào biểu tượng Send 

trên thanh công cụ. 

 

o. Mở tệp đính kèm 

- Nhấn chọn tệp đính kèm cần mở. 

- Nhấn chuột phải, chọn chức năng Open. Cửa sổ Opening... sẽ hiện ra cho 

phép bạn chọn ứng dụng để mở tệp tin 

 

Hình 27. Hộp thoại Open  Attach  file 

 

Nhấn nút <<OK>> để mở tệp tin. 

 

p. Lưu tệp đính kèm theo các bước sau 

Nhấn chọn tệp đính kèm cần lưu. 

- Nhấn chuột phải, chọn chức năng Save As. Hộp hội thoại Save 

Attachment sẽ hiện ra cho phép bạn chọn nơi lưu tệp tin. 
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Hình 28. Hộp thoại Save  Attach  file 

 

- Nhấn nút <<Save>> để lưu tệp tin tại vị trí đã chọn. 

 

q. Xoá tệp đính kèm theo các bước sau 

 

- Nhấn chọn tệp đính kèm cần xoá.  

- Nhấn chuột phải, chọn chức năng Delete. 

Tệp đính kèm sau khi xoá sẽ không thể khôi phục. 

 


